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Preface

This book was created in 2008/2009 by Ntate Cletus Letsatsi, the organizer of the Seliba 

Sa Boithuto Self-Study-Center in Maseru, Lesotho. It is a compilation of a number of 

other computer self-study-books mentioned in the references.

Seliba Sa Boithuto's motto is “Give the responsibility of learning back to the learners.” 

In accordance with  the motto, the Computer Book's aim is to give you the possibility to 

learn about the functions and usage of computers, no matter if you are already well versed 

or just starting off. 

The digital version of the Computer Book was unfortunately lost, so it was necessary to 

digitalize it again in 2011. In the process of doing so, the book was also re-edited, updated 

and expanded by Thabo Letsatsi (Markus Henn) and Moritz Fechner and finally reviewed 

by Alexander Medgett.

In its current version, this  Book is based on the operating system Windows XP and is 

concerned with Microsoft Office 2007 and OpenOffice 3.0. This is the software currently 

used in Seliba Sa Boithuto. 

With the computers provided by Seliba Sa Boithuto and the know-how from this book, 

ideally it should be possible for you to teach yourself the functionality of computers and the 

basic usage of the above mentioned software. Nevertheless you should feel free to ask the 

other learners, the volunteer, the organizer or any other person available for help and 

assistance. 

You should keep in mind that the Computer Book is only dealing with basics of computer 

functionality and usage. If you want to gain advanced knowledge you can use the other 

available books in Seliba Sa Boithuto or the internet for further research. 

Cletus Letsatsi,

Markus Henn,

Moritz Fechner

11. August 2011
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Chapter 1  

Basic Components of a Computer

In this chapter you will learn about basic computer concepts. We will define what a
computer means and discuss basic terms that will be of great help to you in your journey
of learning more about computers. We will discuss different types of computers and the
roles of different computer components.

Learning Objectives

✔ Define a computer and explain basic computer terms.

✔ Know the basic components of a computer system: input, processing, output and 
storage.

✔ Outline and explain advantages and uses of a computer.

✔ Outline and explain types of computers.
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 1.1  What is a computer?

A computer is an electronic multifunction machine that is enable of storing, inputting,
processing and outputting information.

Now, let us pay attention to the terms that have been used to describe what a computer is:

• Electronic means that the computer is powered by electricity. 
• Multifunctional: describes the computer's capability to perform many different 

tasks. 
• Storing: means to keep information in the computer for future use. 
• Inputting: is giving instructions to the computer.
• Processing is when the computer works on the information given to it.
• Outputting: is when the information processed within the system unit is displayed.

Now that we have defined the terms used in this definition you may have a better
understanding of what a computer is. You may have realized that the definition of the
computer does not say anything about the shape and the size of it. 
Let us now discuss different types of computer components. 

The picture above shows an example of one type of a computer called a personal 
computer (PC). It has the parts labelled Monitor, CPU, Keyboard and Mouse. These parts 
can be touched and all parts of a computer that could be touched are collectively called 
computer hardware.
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 1.1.1 Four main components of the computer

The physical parts of the computer, that means the parts which you can touch, are 
collectively called hardware. The four most important parts of the computer's hardware 
are:

1. System unit (CPU)
2. Monitor
3. Keyboard
4. Mouse

Now let us discuss these main components of the computer.

The system unit: This is the brain of the computer; it processes and manipulates (that 
means changes) data from the input devices into the information that the user wants. It is 
also called Central Processing Unit (CPU). 

Monitor: Monitors or screens allow the user to view the programs running on the 
computer. Monitors are similar to TV screens and they are attached to all personal 
computers. As we said in Chapter 1 there are two kinds of monitors: CTR (Cathode Ray 
Tube) and LCD (Liquid Crystal Display).

Keyboard: This is the most common input device. It is used to give instructions to the
computer. A keyboard is a flat plastic board that is covered with keys. Each key has an
letter, number or other character printed on it. Pressing this key will result in that
character appearing on the computer’s screen.

Mouse: The mouse is another input device. It is hand held and it has two to five buttons 
and a wheel. The mouse controls the movement of an arrow called the pointer or cursor on 
the screen. 
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 1.1.2 A Computer System

Like any machine, the computer has certain major parts that are necessary to run it. They 
form what is called the computer system. Those necessary parts are divided up into four 
classes: input devices, output devices, processor, and storage. 

The graphic below shows the computer system model.

Note that the directions of the data paths (symbolized by arrows) also show that 
apart from being sent to the output devices, the results of processing can also be 
stored in the storage devices.

• Input devices accept data in the form suitable to the computer and send the
input to the central processing unit (CPU) for processing. Input is the data that is
put into the computer through input devices. Examples of input devices are; a
keyboard and the mouse.

•  The central processing unit (CPU) processes data from the input devices into the 
information, the user wants and tells other parts of the computer system what to do. It is 
the “brain” of the computer. 

• Output devices show the user the processed information from the CPU in a form
that he will be able to understand and use it. Output is the usable information that
is given by the computer through output devices. Examples of output devices
are computer monitor and printer.

• Storage devices store data and programs on themselves so that the user has access to 
them. Examples are the hard disk, flash-drive as well as CD/DVD ROM. 
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 1.2 Classification of Computers

Computers exist in a variety of different sizes and shapes. Different types of computers are 
capable of doing different tasks so if a person or a company wants to buy a computer it 
has to look for the right model that will meet its needs. Let's have a look at some different 
types of computers now. 

Microcomputers
Microcomputers are the smallest and most inexpensive types of 
computers. The most common microcomputer is the Personal 
Computer (PC), a small desktop computer that is found at home 
as well as in several work places. 
Another kind of microcomputers are the laptops. They are small 

portable computers that fit into briefcases and therefore are 
popular to people who travel a lot and need a computer 
with them.

Workstations/Servers
A workstation is a powerful, high-end microcomputer. They contain 
one or more microprocessor CPUs. They may be used by a single-
user for applications requiring more power than a typical PC 
(rendering complex graphics, or performing intensive scientific 
calculations).
Alternately, workstation-class microcomputers may be used as server 
computers that supply files to client computers over a network. 

PDAs and Smart-phones
A Personal Digital Assistant (PDA) is a hand-held microcomputer that 
trades off power for small size and greater portability. They typically use a 
touch-sensitive LCD screen for both output and input (the user draws 
characters and presses icons on the screen with a stylus). PDAs 

communicate with desktop computers and with each other either by 
cable connection, blue-tooth, or wireless LAN. PDAs are normally used 
to keep track of appointment calendars, to-do lists, address books, for 

taking notes, and for browsing the web.1

A smart-phone combines the functions of a PDA with those of a cell phone. 

Supercomputers
These are the biggest and most expensive computers available; they are 
able to handle billions of instructions each second. Supercomputers are 
rarely used, e.g. for weather forecasting, military defence services and 
scientific research where it is necessary to work with huge amounts of 
data. 
One of the most well known supercomputer is called Cray; it is almost as big 
as have a soccer field.  

1 http://www.unm.edu/~tbeach/terms/types.html
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 1.3 What are the advantages of computers

At one point in life, if you know about computers, you have asked yourself: why are many
people using computers and what is so important about them?

Computers have many important qualities and features that we human beings do no have.

1) Speed: Computers are able to perform calculations a billion times faster than a 
human could. 

2) Accuracy: Computers are very much accurate and always produce the same 
result for the same task regardless of how many times the task is repeated. 

3) Memory: Computers can permanently store large amounts of data in very small 
places and reproduce the data when it is required. Due to this fact computers 
have replaced big space consuming cabinets in many industries. 

4) Reliability: Computers are very reliable and behave as expected under the 
conditions that allow them to operate. 

5) Multitasking: Computers can do many tasks/jobs at the same time. For 
example, you can type a letter on the computer while similarly listening to 
music and browsing the internet. 

11
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 1.4 Uses of Computers

We have looked at the features that make computers special, now let as pay attention on 
how users utilize them. 

(a) Personal Computing: The computer can be equipped with programs for individual 
use. One can use a computer to create all kinds of documents, edit or watch movies 
and pictures, listen to music, etc. Additionly the PC is  the gateway to the internet. 

(b) Information Systems: Most of the work-related use of computers falls under 
information systems. Computers can store information about employees, 
customers, etc. In universities computers are used to register the students, store 
their marks and achievements, monitor their academic progress and process their 
fees. 

(c) Education: Computers are used in various cases by learners to type their 
assignments and projects. It is also possible to access lectures stored on CD/DVD-
ROMs or, if the computers is connected to the internet, you can research 
information online. 

(d) Communication: Computers are used for communication through the internet. 
Private persons use it as well as big companies. Examples of communication via 
internet are: e-mail, chat-rooms, social networks like facebook and online 
advertisement. 

(e) Entertainment: Computers are also used for entertainment purposes. They are 
able to play music and movies and computer games are widely popular. The 
entertainment industry makes use of computers to produce music and movies, e.g. 
to create the special effects in today’s films, or to record music. 
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End of Chapter 1 Questions

1. Define what a computer is.

2. Describe the meaning of the terms that are used in the definition of a computer.

3. State four main components of the computer and say what they are used for.

4. Draw a model of a computer system and name the different components.

5. Give five advantages of a computer and support your answer with examples.

6. Give any five uses of a computer and support your answer with examples.

7. Write the following abbreviations in full: CPU, PC, CRT and LCD.

13
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Chapter 2  

Computer Hardware and Software

In this chapter our main focus will be on the computer's hard- and software. We will 
discuss the different types of hardware as well as software and learn what they are 
needed for and how they are related to each other. 

Learning Objectives

✔ Define computer hardware and software.

✔ Classify the different types of computer hardware.

✔ Differentiate between hardware and software of the computer.

✔ Discuss the relationship between hardware and software of the computer.
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 2.1 Computer Hardware

In chapter 1 we said that the physical components of the computer, that means the parts 
which can be touched, are collectively called computer hardware. We have learned that 
the computer system is made-up of four classes: input devices, output devices, processor 
and storage. 
Now we will have a closer look at each of those categories. 

 2.1.1 Input Hardware

Input hardware are those devices in a computer that are used to enter data. They collect 
input data and convert it into a form that will be suitable for computer's processing. 
Examples of input devices are listed and discuss below.

 2.1.1.1 The Keyboard

The keyboard of a computer is the basic and the most widely used input device. It is used
to type in data into the computer. Some common features of the keyboard are discussed 
below.

1. Standard type writer keys: These are used to type in text and other data.
2. Space bar: The space bar is the long horizontal button. While typing it is used 

to create the empty spaces between the words. There should be ONLY ONE 
empty space between each word and AFTER punctuation marks like full-
stop, comma, question-/exclamation-mark. 

3. Shift Key/Caps Lock: It can be used to make capital letters in a typed text or 
it also allows you to use secondary (upper) symbols shown on the keyboard.

4. Backspace key: It is used to move the cursor to the left while deleting all 
characters in its way. It is also used to delete selected text or pictures.

5. Del (delete): The Del key deletes a character or space to the right of the 
cursor.
Like backspace, it is also used to delete selected text or pictures.

6. Functions keys: These (F1, F2, F3. ..) are used to issue commands.
7. Special-purpose keys: These are keys like Ctrl (control), Del (delete), Ins 

(Insert) and Alt (Alternate). By themselves they do nothing but when 
combined with other keys they can issue certain commands, e.g. Alt + F4 will 
close the running program  or window. 

8. Cursor movement keys: These keys are used to move the cursor round the 
screen.

9. Numeric keys: These are used to enter numbers.
10.Esc (escape) key: This key will cancel an on-going process/program. It also 

may help to quit computer games.

15
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 2.1.1.2 The Mouse

The mouse gets its name from its size and shape and tail-like cable. It is 
used for moving or pointing to objects on the monitor. The position of the 
mouse on the monitor is indicated by the so-called pointer or courser, 
which appears in the shape of a little white arrow on the screen. 
There are mouses that don't have a cable, so they are called 
cordless/wireless mouse. They transmit data via infra-red radiation or 
radio (including Bluetooth). The receiver is connected to the computer 

through a serial or USB port.

The mouse is a simple device, but there is a surprising amount of different ways to use it. 
Knowing how to use it for a particular task will make you more efficient at what you are 
doing. 
Depending on the type of mouse you are using, there are about 4 different types of clicks.

• Left-Click
• Right-Click
• Double-Click
• Click and Drag

Each type of click has their own special purpose:

Clicking means tab the button – pressing it in and then releasing it quickly. The term click 
generally refers to clicking the left mouse button. 

Left-clicking is simply clicking the left mouse button once. This is the most common type 
of click. You should left-click to highlight a folder or file, to navigate a program’s menu, to 
follow a link on a web page, or to click a button.

Right-clicking is clicking the right mouse button once. If you right-click on an object, a 
shortcut-menu pops up that lets you perform various actions associated with the object 
such as copy&paste, renaming or deleting it. 

Double-clicking is quickly clicking the left mouse button two times. Double-click a folder 
to open it, double-click a program to run it. 

Click and dragging is left clicking on an item once and holding the button down while you 
move the mouse. Dragging is frequently used to move or resize items on the screen as 
well as to highlight several objects or words at once. When you have dragged the item to 
its new location, you drop it by releasing the mouse button. This procedure is called 
drag&drop. 

Scrolling: All modern mouses have a scroll-wheel, located between the left and the right 
mouse button. Moving the scroll-wheel up and down will slide the text, pictures, window 
etc. on the screen up and down. 

16
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 2.1.1.3 The Scanner

A scanner is used to “copy” pictures or text printed on paper into the 
computer. It can be compared to a photocopying machine, only that it 

does not duplicate the given picture/text onto another sheet of paper 
but instead puts it into the computer. 

If you have copied a picture of a letter from paper into the computer, you 
can recognize the printing characters by using special software that 

changes the picture into an editable text document. 

 2.1.2 Output Hardware
Output hardware refers to computer devices that provide us with means of viewing the
results produced by the computer in a way that is easy to understand.

 2.1.2.1 Computer Monitors

The monitor or screen produces the visual responses to user requests or it shows the user 
the processed information from the central processing unit in the form that is easy to use 
and understand. Monitor‘s are also called screens. 
Screens all have control buttons usually found on the front that allow you to adjust the 
brightness and contrast of the screen. 
There are two types of screens: CRT (Cathode Ray Tube) and LCD (Liquid Crystal 
Display).

CRT Screens: These are large screens. 
LCD Screens: These are small and flat screens. Portable computers like laptops 

have flat screens. 

17
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 2.1.2.2 Computer Printers

A printer is used to print documents and pictures stored in the computer onto 
paper. Most personal computers are equipped with ink jet printers, at 

places likes schools and offices, Laser jet printers are commonly used, 
which are, compared to Ink jet printers, more expensive but can print a 

lot faster. 
There are some multifunctional devices that combine two or more of 
the following: Printer, scanner, copier, fax and/or telephone.

 2.1.3 Processing Hardware
Let us now look at the piece of hardware that does all the processing once data has been 
enter into the computer through the input hardware. As its name suggests, the central 
processing unit (CPU) is responsible for almost all processing that is done in the computer; 
therefore it is also called the computer's brain. 
The CPU is typically a square ceramic package plugged into the motherboard, with a large 
heat sink on top (and often a fan on top of the heat sink). It consists of two parts: the 
control unit (CU) and the arithmetic/logic unit (ALU).

Control Unit

The control unit directs the activities of the computer, which are, the transfers of data and 
the instructions between the ALU and the main memory. Moreover It  controls the activities 
of the input/output devices as instructed by the computer programs.

Arithmetic/Logic Unit

The arithmetic/logic unit (ALU) performs the computer’s arithmetic operations, that means 
calculations such as addition, subtraction, multiplication and division. It also performs 
logical operations.

CPU and Memory

The random access memory (RAM) is part of the processing hardware. It temporarily 
holds data and instructions that are being used by the CPU. The CPU can utilize only 
those software instructions and data that are stored in RAM.
Most new PCs have so-called dual core processors, which means that they are equipped 
with two separate CPUs. Dual core processing is faster and better at doing multitasking. 

18
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 2.1.4 Storage Hardware

In the previous section we have learnt about how data is entered into the computer and 
how it gets processed. Let us now look into storage hardware devices. These are 
hardware devices that provide means of storing data, either temporarily or permanently.

 2.1.4.1 The storage of data

Storage space is measured in bit; 8 bits make one byte (B). 

Name Abbreviations = B x ... Example
bit b n/a single printing characters
Byte B 1 text files
Kilo Byte KB 1.000 documents
Mega Byte MB 1.000.000 pictures, mp3-files (music)
Giga Byte GB 1.000.000.000 movies, video games
Tera Byte TB 1.000.000.000.000 hard drive space

 2.1.4.2 Primary and Secondary Storage

Computer storage consists of primary storage and secondary storage. 
Primary storage also called RAM refers to the main memory of the computer, where data 
and instructions are temporarily kept for immediate use by the computer’s CPU. 
Secondary storage stores data and software instructions permanently and does not work 
directly with the CPU. Examples of secondary storage devices are hard disk, CD/DVD-
ROM and flash drive.
Let's discuss the examples of secondary storage more closely now:

 2.1.4.3 Hard Disk

A hard disk (HD) is a permanent device for storing digital data. It features rotating disks on 
a motor-driven spindle within a protective enclosure. Data are magnetically read from and 
written to the disks by read/write heads that float on a film of air above the disks. Every 
hard disk is divided into many sectors, each containing a certain amount of data. Today's 
HDs operate on high-speed serial interfaces; i.e., serial ATA (SATA) or serial attached 
SCSI.
Usually the HD is integrated inside the computer so it is not portable, there are however 
so-called external hard drives. They are not build-in the computer but are enclosed in a 
metal case separately from the computer. If you want to make use of an external HD you 
have to connect it to your computer via USB-port (universal serial bus). 
The external HDs are usually big and unhandy but they can store huge amounts of data. 
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 2.1.4.4 Portable storage devices

The storage devices are grouped into internal and portable. Internal storage devices 
cannot be removed from the computer, while portable storage devices can easily be 
carried between and used with different computers. 

CD-Disk

CD stands for compact disk .In its case a laser is used to burn data into the disk, making a 
permanent storage record. The data is later read by shining a laser beam through the 
bottom of the disk and monitoring the amount of light reflected back. The 
disadvantage of  CDs is that once data has been written to them, it 
becomes  impossible or complicated to add, delete or 
change the data saved on it. 

DVD Disks

DVD stands for digital versatile disks. A DVD looks like a CD, but 
can store more data.  Where as a typical CD ROM stores 650 MB a DVD 
can usually store 4.7 GB. DVD discs transfer data to the computer fast, therefore it allows 
you to watch movies stored on it. 

Flash Drive

A USB flash drive consists of a flash memory data storage device 
integrated with a USB (Universal Serial Bus) interface. USB flash drives 
are typically removable and rewritable, and physically much smaller than 

a external hard disk. Most weigh less than 30 grams and storage 
capacities in 2010 can be as large as 256 GB with steady improvements in size 

and price per capacity expected.

 2.1.4.5 Storage space of different hardware

Internal storage devices

• RAM 512 MB to 8 GB
• HD 320 GB to 3 TB

Portable storage devices

• CD 700 MB
• DVD 4.7 GB
• Flash-drive 1 GB to 64 GB
• external HD 320 GB to 3 TB
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 2.1.5 The Motherboard

The motherboard (also called mainboard), is is a large, thin, flat, rectangular fibreglass 
board (typically green) attached to the inside of the computer's case. The motherboard is 
the interface between all the other hardware devices, which means that it connects them 
to each other and exchanges information between the hardware devices. Motherboards 
usually contain one or more CPUs, supporting circuitry providing the interface (connection) 
between the CPU memory and input/output devices and the main memory (RAM). 
Most modern motherboards have onboard sound (needed to hear sounds and music on 
the computer) and LAN (needed to connect to a network and to the internet) controller, 
some of them even have onboard graphics (needed to show animation, pictures, games, 
movies etc. on the screen). Nevertheless it is possible to equip the computer with 
dedicated sound and graphics cards plugged into the expansion slots which offer much 
better quality and performance than onboard devices or other cards, like TV and FireWire 
(also called IEEE 1394 interface) which add more functions to the computer. 

 2.1.5.1 USB
USB (Universal Serial Bus) is an industry standard 
developed in the mid-1990s that defines the cables, 
connectors and protocols used for connection, 
communication and power supply between computers and 
electronic devices.

USB was designed to standardize the connection of 
computer peripherals, such as keyboards, mouses, digital 
cameras, printers, flash-drives and mp3-players both to 
communicate and to supply electric power. It has become common on other devices, such 
as new mobile phones and video game consoles. 

You can also have a closer look at most of the hardware components that are 
discussed above and see how they are connected to each other at the exhibition in 

the compute room.  
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 2.2 Computer Software

We learned that the physical components of the computer system are 
collectively called computer hardware; however the computer's 
hardware is unusable without the computer's software. Software, also 
known as computer programs or simply programs are a series of 
instructions that tell the hardware of the computer what to do. There is a 
bit of a similarity to the humans here. Just like the physical parts of the 
human body are guided by our minds, so is the computer hardware 
guided by computer software.
Additionly Software can  be described as the conjunction between the computer's 
hardware and the user because it shows the user a program's possible action within a 
graphical user interface (GUI). We realize here that the whole set of computer hardware 
connected correctly is useless without the software.

Software is generally categorized into operating system and applications software. Let us 
discuss each one more precisely now.

 2.2.1 Operating System

One could look at operating system (OS) as the programs that are designed to perform 
tasks associated with directly controlling and utilizing the computer's hardware. The OS 
does not accomplish specific task like creating a table or document for the user but it 
provides a basic environment in which other software can work properly. It is the 
fundamental and central manager of all software activities and equipped with programs 
that monitor and control all input and output activities as well as processing activities within 
the computer system.
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 2.2.2 Application Software

Application software is regarded as the software that is applied to solve a certain problem 
or perform a particular task for the user. For example, application software can enable a 
user to draft a letter, draw a graph or watch a movie. Each piece of software is designed 
to perform a specific entertaining, business or scientific tasks.

Most applications software is developed to do a common task for all users of the computer 
system. The software is not designed to target one certain 
business. For example. word processing software could be used in 
any industry or private person. Some of the most popular kinds of 
application software are office software (word-processing, 
spreadsheet, publishing, data base and presentation), multimedia 
software (video/music players, graphic programs), games and web-
browsers. 

• Word processing software: This is one of wildly used 
application software. It gives the user the opportunity to 
create and edit text documents such as letters, assignments or applications. 

• Spreadsheet software is normally referred to as spreadsheet; it allows the user to 
develop spreadsheets. The spreadsheet is made up of columns and rows. An 
electronic spreadsheet is similar to a conventional spreadsheet as used by 
accountants; the only difference is that it is now the computer that does the 
calculating.

• Desktop publishing software: This software allows the user to produce sophisticated 
combination of text and graphics. It is the software that is used to produce 
newspapers, magazines and newsletters. 

• Database Software: This is the standard application software used for organizing 
files and records. The software allows you to store large amounts of data that can 
easily be retrieved. monitored and manipulated with great flexibility to produce 
meaningful reports, huge lists and selected information. 

• Multimedia Player: A multimedia player allows you to watch/listen to videos/music 
on the computer. 

• Web-browsers: The web-browsers enables you to access and surf the internet. It 
shows web-pages and  also can be used to search the internet. 
Nowadays web-browsers have become multifunctional and are used to check your 
emails, purchase in online shops, chat with people worldwide and do the tasks of 
multimedia players.
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End of chapter 2 Questions

1. Define the term hardware and give four examples. 

2. Explain the purposes of the four examples of hardware given above. 

3. Give the four main classes of computer hardware that we discussed in this chapter. 

4. Give four examples of secondary storage. 

5. Define the term software. 

6. State two categories of computer software and discuss each in a few lines.(wird so 
plural geschrieben von software?

7. State two types of application software and discuss them in a few lines.
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Chapter 3  

Computer Operating Systems

In the previous chapter we said the operating system (OS) consist  of programs that are 
designed to perform tasks associated with directly controlling and utilizing the computer's 
hardware. In this chapter will take a more detailed look on the OS, its functions and its 
relationship to the computer's hardware. 
We will also discuss the use of folders and files. 

Learning Objectives

✔ Define an operating system.

✔ Discuss the role of an operating system in a computer.

✔ Explain the benefit of an operating system to the user.

✔ Discuss the responsibilities of the operating system. 

✔ Describe the procedures of starting and shutting down a computer.

✔ Describe procedures of starting and quitting programs.
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 3.1 Operating System

An operating system is a family of programs that monitor and control all input and output 
activities and processing activities within the computer system.

As we have seen in the previous chapters, a computer is basically a useless lump of metal 
without its software. However with its software, a computer can store, process, and 
retrieve information, find spelling errors in manuscripts and engage in many valuable 
activities. We also learned that the OS is the fundamental and central manager of all 
software activities. Itis equipped with programs that monitor and control all input and 
output activities as well as processing activities within the computer system Therefore we 
can say, that the OS is the most important software on the computer. 
All the application software that is installed on a computer is designed to work together 
with the computer's OS. 

Responsibilities of an operating system

• It utilizes the computer's hardware. 
• It monitors all input and output devices. 
• It controls the computer system by interpreting and executing commands 

issued to the computer.
• It manages usage of computer resources.
• It manages files and folders on the computer.
• It allows installation, loading and closing of applications software.

As all other software, the OS is stored on the HD. The process during which the operating 
system is loaded-up to when it is ready for use is called booting. 
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Now you are probably asking your self, “what does an OS look like?”. 
When you switch on a computer, the screen or the monitor always show the operating 
system that is used by the computer. It could be Windows XP, Windows Vista, Windows 7, 
Linux or MAC OS. All these are examples of OS' that normally run on personal computers. 

 3.2 Starting the computer
If you want to start a computer, you have to press the on/off-button (see 
picture left-hand side) on the computer's case. Sometimes you also have to 
turn on the computer's monitor, using another on/off-button located on the 
monitor. 

 3.3 Logging on to a computer

When you switch on the computer, the OS running will ether presents the welcome screen 
or automatically log you on. If the welcome screen is presented you have to log on to the 
computer manually before you can use it. You will have to selected a user-account and, 
depending on the user-account settings, you might have to type in a password which 
unlocks the account so  the computer can identify you. 

 3.4 Shutting down the computer

We said after the computer is switched on; the OS takes control of the computer. This 
means, the computer is shut down by using the OS and NOT using the on/off-button. 
When you are finished using the computer you can shut it down by following a certain 
procedure: 

1. Before shutting down the computer you have to make sure that all the 
programs that were running on the computer are closed.

2. Click the start button, and then select Turn Off Computer from the start 
menu. Now, the shut down box will appear.

3. You now can choose between Stand By, Turn Off and Restart
4. Click on Turn Off. 
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Note: 
1. Stand By places the computer in power saving mode. The monitor, hard disk 

and fan turn off and other hardware are put into the lowest power state. Press 
any key or simply move the mouse to switch the computer on again. Standby 
can be used if you take a break from work and want to continue after a short 
period.

2. Turn Off closes all running programs and shuts down the computer.
3. Restart shuts down the computer and than automatically restarts it. Restarting 

your computer is the first thing you should try if you find that windows or another 
program isn't working properly. 
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 3.5 Working with Windows

This book is mainly focusing on the OS Microsoft Windows XP. We will take a closer look 
on how to work with Windows now.
When you start Windows, you will see the following:

 3.5.1 Desktop

In Windows XP, your computer monitor's screen is known as the Windows 
desktop. It is the area where all your work takes place. You can create files and 
folders right on your electronic desktop and arrange them on the screen.
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 3.5.1.1 Desktop icons
On the desktop you can see some icons, representing files, folders and programs as well 
as My Computer and the Recycle Bin. 

• My Computer: My Computer shows you the contents of your floppy disk, hard disk, 
CD-ROM drive, and network drives. You can also search for and open files and 
folders, and gain access to options in Control Panel to modify your computer's 
settings.

• My Documents: My Documents is a shortcut to the special folder where all your files 
and documents are stored. 

• Recycle Bin: Programs and files that were deleted are found in the Recycle Bin. As 
long as a program or file which got deleted is still in the Recycle Bin you can 
recover it. If the Recycle Bin is emptied, all previously deleted programs and files 
are deleted permanently. 

• Program icons: On the desktop you can see some icons which are shortcuts to 
certain programs. To start a program using the icons, simply double-click on the 
icon. 

Note: Because all the learners are sharing the My Documents folder in the Seliba 
Sa Boithuto, it is necessary for you to save your files into your own folder and 
NOT directly into the My Documents folder.  
In Seliba Sa Boithuto the My Documents folder is stored on the server, so you 
can access your files from all the computers, which means that you do not have to 
work on the same computer all the time

 3.5.1.2 Shortcuts

Shortcuts are quick ways to get to the items you often use. You can customize the desktop 
by creating your own shortcuts. A shortcut can be created for any type of object- a file, 
program, folder, printer or even hard disk. When opening a shortcut (by double-clicking) 
the object that it is pointing to will  automatically be activated. Shortcuts are distinguished 
by a little arrow ( ) at the bottom left of the icon.

Creating a shortcut
1. Copy the object of which you want to create a shortcut.
2. Right-click at the location you want to create the shortcut.
3. Choose Paste Shortcut.

Note: Delete a shortcut
Deleting the shortcut does not delete the item to which the shortcut is linked. 
The original object is still exists on the hard disk.
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 3.5.2 Start menu

Most of the programs (e.g. Microsoft Word, Microsoft Excel, Microsoft PowerPoint) in your 
computer are loaded from the start menu on the programs section. 

Starting a program

1. Click the start button, and then click on All Programs. 
2. Select the program or category you want from the new sub-menu. Your 

option may give rise to another menu that may contain what you want. 
3. When you have found the program you have been looking for, click on it

 3.5.3 Quick Launch
The Quick Launch is placed next to the start menu button. It contains several program-
icons. To start a program which is placed in the quick launch, simply click on it. 

If you press the desktop-icon (       ) or WIN + D all windows will be minimized to the 
taskbar and the plain desktop will be displayed. 

 3.5.4 Taskbar
If a program is launched, you can see it in the taskbar, even if it is not on the screen. You 
can switch between different programs by clicking on them in the taskbar 

Note: On the right-hand-side on the taskbar are some icons representing a running 
program. Right-click to get more options. Click      to show hidden icons.

 3.5.4.1 Volume

           Click the icon on the left to change the volume settings.
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 3.5.4.2 Clock and Calender
In the bottom right corner of the desktop, you find the clock. It tells you what time it is. If 
you move the cursor on it but with no clicking, the date will be displayed. If you double-
click it, the calender and the settings will be shown. 
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 3.6 Window management

If you open a program or folder it will always appear in a window. For example we have a 
picture of the My Computer window below:

• Title bar: The title bar displays the name of the current file, folder or program. If you 
double-click into the title bar you can maximize or restore the window's size. If the 
window is not maximized and you click & hold into the title bar, you can move the 
window on the screen by moving the mouse. 

• Caption buttons: The caption buttons allow you to (from left to right) minimize, 
maximize/restore and close the current window. If you minimize a window, it will 
disappear but it won't be closed. You can access minimized programs from the 
taskbar by clicking on them. 

• Menu bar: All windows/applications have a menu system with a list of commands to 
choose from. The common menu heading in many application's is the File. This 
menu will show you several options to choose from if you click on it: for example: 
New, Open, Close, Save, Save As, Print, etc.

• Scroll-bar: The scroll bars may appear on the horizontal and the vertical borders of 
a window and indicate that there is information that is not displayed at the moment. 
The scroll bars are used to move from left to right (horizontally) and up and down 
(vertically) to view the unseen parts. The scroll-box indicates the current position in 
the window or document. It can be moved to display the unseen parts. If it is at the 
top of the window, as shown in the example above, you see the upper beginning of 
the window or document. 
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 3.6.1 Folder navigation

You can navigate to every folder on the computer by opening My Computer from the 
desktop. From the  My Computer window you can open all hard drives, mobile storage 
devices and network folders by simply double-clicking them. Then you can move through 
the folders and sub-folders by double-clicks. 

Now lets have a look at the navigation pane:

Click the        - button in the toolbar to go back to the folder you just came from. Click the 
down arrow next to the        - button to view a list of previous locations you can jump back 
to.

 3.6.2 Saving your work

We know that the computer’s memory (RAM) holds files only temporarily, that means while 
the computer is still on. Contents of the memory are lost when the computer is switched 
off. This means that you have to save your files on a permanent storage (hard disk or flash 
drive) before you close a program or shut down the computer. Remember that you have to 
give the file a name (file name). The file name is the file's identity on the storage, so if you 
want to retrieve your file, you have to recognize the file name. If you do not remember 
where you have saved your file, but you still remember the file name, you can search for it, 
as explained in Chapter 3.
If you want to save a new file, the programs sometimes suggests a file name like book1, 
untitled1 etc. You should avoid those file names, because they do not specify the files 
content. The file name should always refer to the files content, so if it does not, you have 
to change it to avoid confusion. If the precise day when you created the file is important to 
you, you should also add the date to the file name. 

To save a document or file:

1. In almost every program that runs in a window you can click File in the menu 
bar.

2. Selected the Save (Ctrl+S) or Save As. If you choose Save as you can save 
a copy of your work in an other  folder or with an other name.

3. Now decide in which location you want to save the file.
4. Once you have specified the location, you can enter or change the file name.
5. When you are satisfied with the file's location and name, click Save.
6. Now your file will be store in the location you have specified.
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 3.6.3 Closing a window/program

After you are finished using a program you should quit it in the correct way. 
To quit/exit an application, make sure that your current work has been saved by using the 
Save or Save As option. Now you can ether close the window/program by clicking on the 
close button form the caption buttons or by clicking on File in the menu bar and then 
clicking on Exit or Close. 

 3.7 Managing folders and files

Now that we have taken a look at window management, we shall also learn about how to 
manage folders and files. 
All the different things that you can save on a computer like documents, tables, pictures, 
etc. are collectively called files. If you save files on the computer, you should put them into 
a folder with similar files, so it is easier to find them again. 
Folders make it easier to give order and structure to the files saved on the computer. Let 
us clarify that by an example: If many different people work on one computer, each one of 
them should have a one folder for his or her files so that the files of different users do not 
get mixed up. 

 3.7.1 Creating Folders

Usually all your files should be saved into the My Documents folder. To access My 
Documents, double-click it on the desktop. If you do not have an own folder in My 
Documents, you can create one, following the instructions below:

1. Double-click on My Documents. 
2. In the My Documents window, click File in the menu
3. On the File menu, click New, and then click Folder. Then a new folder will 

appear labelled “New Folder”. 
4. If you want to change the folder's name right-click on the folder and then click 

rename. After that you can type in the new name. Press Enter if you are 
finished. 
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 3.7.2 Copy and moving files and folders

Sometimes you want to change the place where a file or folder is saved or you want to 
make a copy of a folder/file and save that copy on an external storage device. 
To copy or move a file:

1. Open a window containing what you want to copy or move, and then select 
that file or folder.

2. On Edit from the menu, click Copy to copy the file or folder or click Cut to 
move it. 

3. Open the folder in which you want to place the file or folder that you 
copied/cut before.

4. Selected Edit from the menu again and click Paste. Now the file or the folder 
will appear in new location; that may take some time, depending on the 
folder's/file's size. 

 3.7.3 Deleting folders and files

As a computer allows you to create folders and files, it also allows you to delete 
them if they are of no use to you any more. When you delete a folder or files it is 
send to what is called a Recycle Bin. In case you change your mind and decide to 
retrieve it back you will find it in Recycle Bin.

To delete folders and files:

1. Select the folder or file that is of no use to you any more.
2. On the menu click File, then click Delete.
3. The confirmation the file delete dialogue appears, asking you whether you 

want. to delete the folder or file. Click Yes. The folder or file is then deleted 
and transferred into the Recycle Bin.

Restore previously deleted folders or files from the Recycle Bin:

1. On the desktop double-click the Recycle Bin. 
2. Right-click the folder or file you want to restore.
3. Select Restore from the new menu. 
4. The folder or file will now be restored to its previous location.
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What if you permanently want to remove the file in the computer?

1. On the desktop double-click the Recycle Bin. 
2. Then open the File menu and select Empty Recycle Bin. 
3. Now the Recycle Bin will be emptied and the files will be deleted permanently 

from the computer system. 

 3.7.4 Searching files and folders
Sometimes you forget were a file or folder is located. Fortunately, Windows has a search-
function which helps you to find files and folders. You can search for folders by (parts of) 
their names, by text they might contain or by their suspected location. 

1. Open the folder were you suspect the file that you are looking for, if you have no 
idea at all, start from the desktop. 

2. Press F3 to open the search-function.
3. Specify the type of file that you are looking for. 
4. Key in the file's name or parts of it.
5. Click Use advanced search options to get further search options like file size or 

location.
6. When Windows is finished searching (that can take quite a while) 

you get a list of all files that 
match the terms that you were 
looking for. 
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 3.8 Printing documents

If you are satisfied with your work and a printer is connected and switched on, you can 
print it out. Some programs like Microsoft Word and OpenOffice allow you to view the 
document on the screen the way it will look on paper (print preview). 

The printing setup gives you a variety of options for printing your work. You can print it as a 
whole or you can choose to print only certain parts/pages. It is also possible to print 
multiple copies and to change the quality and  the colours (coloured or black&white) of the 
print out. 

To print your file, click File in the menu bar or press Ctrl+P. Now the printing menu will 
appear and you can choose between the options that we discussed above. 
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End of Chapter 3 Questions

1. Explain what an operating system is.

2. State the importance of an OS to the computer system.

3. Give any three examples of OS' that you know about.

4. What is the name of the process that takes place when the operating system is 
being loaded?

5. What are the steps to be followed when logging into a computer system?

6. What are the steps to be followed when shutting down a computer?
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Chapter 4  

Introduction to Word Processing

In this chapter we are going to learn more about word processing. We will explore the 
basic concepts in word processing like creating a document, editing, formatting, saving 
and printing it. We will have a closer look at two common word-processing software, 
Microsoft Office Word and OpenOffice Writer. 

Learning Objectives

✔ Divining word processing and word processor. 

✔ Explain in detail how a text is entered and edited in a document.

✔ Explain different ways of formatting a document. 

✔ Explain in detail the concepts of saving and printing a document. 
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 4.1 Definition of word processing

Word processing involves a lot of activities that must be handle by word processing 
software. Word processing software lets you create, edit, format, review, store and print a 
text document. 

Let us pay attention to the terms that have been used to describe what word processing is:

• A text document is any text that can be typed in the computer, such as a 
letter.

• Creation means to make something. 
• Editing is making changes to a document to improve its content or to make it 

suit your purpose-for example by adding additional parts or by removing and 
reconstructing existing ones. 

• Formatting refers to adjusting the appearance of the document to make it 
look appropriate, attractive and organized. For example, you may want to use 
double spacing instead of single spacing.

• Reviewing is to look for spelling and grammar mistakes. Word-processing 
software can automatically spot some of those mistakes. 

• Storing the document means saving it so that it can be accessed on demand.
• Printing is producing the document on paper, using a printer connected to the 

computer.

You may think word processing is just glorified typing but it is not. Let us discuss 
advantages of word processing over typing.

 4.2 Advantages of word-processing software

There are many benefits that we get from word-processing software. 

When using word processing package, you can make changes as you go along, or even at 
some later time, and print out a revised-and perfect-copy. But with type writing all this 
editing of document is not possible.

The abilities to print at will and store work. distinguish word processing from typing.
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Most word processing software packages come with additional software components that 
are of great importance when writing documents. Let us discuss a few.

• The main advantage of word processing is that after the text has been enter into the 
computer and is visible on the monitor, it can easily be reviewed, edited, formatted, 
saved and printed. 

• Once a text document has been saved on a computer it can easily be shared 
amongst many persons using mobile storage devices (such as a flash-drive) or the 
internet. 

• Spelling checker: Word-processing software has a feature that allows user to check 
wrongly spelled words and it suggests words that are very close to the misspelled 
word. 

• Grammar checker: Some word-processing software can also check grammatical 
mistakes or notify you of possible grammatical mistakes as you work on your 
document. 

• Thesaurus: This component gives you synonyms of words. You may prefer to use a 
certain word for another word. (Example: if you type in manage, thesaurus will give 
you some synonyms like “run, direct, minister, supervise, cope get by, etc.”.

• Search/Replace: Most word-processing software have a facility that allows you to 
search for a particular word in the whole document and replace it with another word 
of your choice. 

 4.3 Creating a document

Now that you know some important features of word-processing software, we will look at 
how to create a document. Before you can create a document in word-processing software 
you have to launch the necessary software. Commonly used word-processing software is 
Microsoft Words and OpenOffice. 

4.3.1 A document page

After word-processing software has been loaded into the computer’s memory, a 
blank white screen, a toolbar and the menu-bar is displayed. The blank screen is the first 
page of the document on which text can be entered. A cursor “|” is always shown at the 
beginning of the first line of the first page. The cursor indicates the position where text will 
be inserted when typed in. When the word-processing software has been launched and 
the cursor is blinking, the text can now be type in using the keyboard. The text just flows 
on the first line with the cursor leading to show where the character (letters) will appear. 
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 4.4 Editing and reviewing a document
We said editing is making changes to a document to improve its content or to make it suit 
your purpose and reviewing is to look for spelling and grammar 
mistakes. As human beings, we cannot do away without making 
mistakes when we write, as a result; an appropriate facility for 
producing documents is the one that allows users to make 
corrections. Editing and reviewing a document involves many 
activities, like deleting and inserting letters or copying and replacing 
text. 

 4.4.1 Upper and lower cases
In chapter 2, we already explained that the Shift Key/Caps Lock can be used to switch 
between upper and lower cases. It also enables you to use the secondary symbols 
like !,@,#,$,% etc. If you press a letter while you hold shift key, the letter will be capital. If 
you press caps lock, all the letters that you press afterwards will be capital until you press 
caps lock again. Use caps lock if you want all the letters in a word to be capital. Otherwise, 
if you only want to make the first letter of a word capital, use shift key.

 4.4.2 Inserting and over-typing
Text is entered in a document either in insert mode or over-type mode. When you enter 
text in over-type mode starting at a certain position, all the text to the right is replaced by 
the new text. Existing text does not shift but typing occurs over it and it is replaced.
In insert mode starting at a particular position, all the words to the right of the text that you 
are typing in automatically shift to create room for the additional text. 

 4.4.3 Inserting and Deleting
It is often the case when you are typing a document you realize there is a certain letter or 
word that you want to delete in it. Word-processing software allows that to take place 
without deleting the whole document. To delete a certain part of a document, place the 
cursor before or after it using the cursor movement keys (arrow keys on the keyboard). A 
backspace key is used to delete characters (letters) to the left of the cursor while the 
delete key is used to delete characters to the right of the cursor. If you want to insert some 
text at a certain position, place the cursor before that position in the document and start to 
type whatever you want to insert. 

Note: All computers at Seliba Sa Boithuto are equipped with a type-learning 
-program: Start → All Programs → Education → Tipp10 
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 4.4.4 Marking text inside a document

You can mark single parts of a document, like a letter, words, sentences, paragraphs or 
even pages. After you have marked a certain part of the document, everything that is 
marked can be formatted easily, because whatever you do now, will apply to everything 
that is marked. For example you can delete a whole paragraph by marking it and then 
pressing delete or backspace only once. 

You mark a part of the document by using the mouse:
1. Move the pointer to the beginning of the section that you want to mark.
2. Click & hold the left mouse-button.
3. While still holding down the left mouse-button, move the pointer to the end of 

the section that you want to mark. While you are moving the mouse, the part 
that is marked will be highlighted. 

4. If you have highlighted the correct part, you release the left mouse-button. 
5. Now you can format the highlighted text.
6. When you finished working with the highlighted text you unmark by pressing 

one of the cursor movement buttons (arrow keys). 

 4.5 Microsoft Office

Then most popular office software is Microsoft Office. It is used wildly by companies, in 
schools and universities as well as by private persons. Microsoft Office is a package of 
different software necessary in an office like database, presentation and spreadsheet. The 
specific software within Microsoft Office that is responsible for word-processing is called 
Microsoft Word. It can be used to create, format and edit almost all kinds of text 
documents such as private letters, applications, assignments, etc. It gives you tons of 
different formatting options, including putting pictures in a text document. 
The biggest down-side to MS Word is, that it has to be bought. Later in this chapter we will 
also discuss OpenOffice Writer which is another word-processing software, similar to MS 
Word, but for free. 
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 4.5.1 Overview

If you launch MS Word, it will display an empty page and some buttons around it:

 4.5.2 Office Button

The Office Button can be compared to File from the menu bar. If you click the Office 
Button, a menu with common options like New, Open, Save, Save As and Print will be 
displayed. Further information on each option will be displayed if you move the cursor on 
the option.
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 4.5.3 Quick Access Toolbar

The Quick Access Toolbar is a toolbar that contains a set of much-used commands that 
are independent of the ribbon that is currently displayed. 

The icons on the Quick Access Toolbar from left to right:

Save: This button saves your work (shortcut key: Ctrl+S).
Undo: Undo reverses the last command or the last entry you typed. To select the 
command that you want to reverse, click the arrow next to the Undo icon on the Standard 
bar (Ctrl+Z).
Redo: Redo reverses the action of the last Undo command. To select the Undo step that 
you want to reverse, click the arrow next to the Redo icon on the Standard bar (Ctrl+Y).

 4.5.4 Help

Click the Help button to open the MS Word help menu. In there you can find help to almost 
all options or commands of Word. 

 4.5.5 Tab-bar and the Ribbon

The ribbon is designed to help you quickly find the commands that you need to complete a 
task. Commands are organized in logical groups, which are collected together under tabs. 
Each tab relates to a type of activity, such as writing or laying out a page. To reduce clutter, 
some tabs are shown only when needed. For example, the Picture Tools tab is shown only 
when a picture is selected.

Now we will have a look at the most important commands from the tabs. We will, however, 
not explain all of them. If you want to work with some of the commands, not featured in this 
explanation, you can always use MS Word's Help. First of all, we will have a  look at the 
Home tab.
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 4.5.5.1 The Home tab

Cut, Copy and Paste. Those three buttons allow to cut, copy and 
paste within your document.(for further explanation see above 3.7.2 
copy and moving files and folders).

Format Paintbrush: Adopts a format, for example bold and applies it 
to another part of the document. First select some text or an object, 
then click this icon. Then click on or drag across other text or click an 
object to apply the same formatting.

Non-printing Characters: If you activate this button, empty space 
between words (·), empty paragraphs (¶) and tab stops (  →  ) will be 
displayed as indicated in brackets.

Font Name allows you to select a font name from the list or enter a 
font name directly. 

This font is called Arial. 
This font is called Times New Roman. 
This font is called Comic Sans MS. 

Font Size allows you to choose between different font sizes from the 
list, or to enter a size manually.

The font size is 8.
The font size is 12.
The font size is 16.

Bold makes the selected text bold. If the cursor is in a word, the 
entire word is made bold. If the selection or word is already bold, the 
formatting is removed.

Italic makes the selected text italic. If the cursor is in a word, the 
entire word is made italic. If the selection or word is already italic, the 
formatting is removed.

Underline underlines the selected text or removes underlining.
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  Align Left aligns the selected paragraph(s) to the left page   
  margin.

Centred centres the selected paragraph(s) on the page.

Align Right aligns the selected paragraph(s) to the right page 
margin.

Justified aligns the selected paragraph(s) to the left and the right
page margins. 

Bullets On/Off assigns bullet points to the selected paragraphs, 
or removes them from bulleted paragraphs. To change the style
 of the bullet points right-click into the paragraphs then select 
Numbering or Bullets from the menu.

Now you can click the style of bullet-points or numbering you like. 
Multilevel List creates a list of bullet-points or numbers that are sorted 
by importance, so a main-headings are emphasized while sub-
headings are shifted to the right.

Click the Decrease Indent icon to reduce the left indent of the current 
paragraph or cell content and set it to the previous default tab 
position.
Click the Increase Indent icon to increase the left indent of the 
current paragraph or cell content and set it to the next default tab 
position.

Click to apply the current font colour to the highlighted characters. 
You can also click here, and then drag a selection to change the text 
colour. Click the arrow next to the icon to open the Font colour toolbar 
where you can select a different colour. 

Highlighting applies the current highlight colour to the background of a 
text selection. If no text is selected, click the Highlighting icon, select 
the text that you want to highlight, and then click the Highlighting icon 
again. To change the highlight colour, click the arrow next to the 
Highlighting icon, and then click the colour that you want. 

Highlighting paragraph works in the same way as highlighting but the 
whole paragraph gets highlighted.
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Line spacing

If you want to in- or decrease the space between the lines of the text, 
you can highlight it, click on the line spacing button and then choose 
the spacing you like. If you are not happy with the preselected 
spacing options, you can click Line Spacing Options. 

Example: The paragraph below has double line spacing.

If you want to in- or decrease the space between the lines of the text, 

you can highlight it, right-click on the highlighted area, select line 

spacing, and then choose amongst Single, 1,5 lines and Double.

Superscripts and subscripts

Word allows you to insert superscripts and subscripts. A superscript is 
a textual addition written slightly above a character on a line of text. 
This is normally used when writing dates like '3rd of Jan 2012’. The 'rd' 
is the superscript in this case. A subscript is a textual addition written 
slight below a character on a line of text. The subscripts are normally 
used when writing chemical formulas. I.e. CO2. In this case ‘2’ is 
actually the subscript.
Sometimes, as in the case of dates, Writer will automatically apply 
super/subscript. If you want to apply super/subscript manually, you 
have to highlight the letters/number that you want to change. Now 
click sub/superscript button. 

Styles enables you to assign styles to parts of the document. To 
assign a certain style to a specific part of your document, mar the part 
and then choose the style you want from the Style menu. There is 
already a preset of different styles fitting different purposes like 
Heading 1, Heading 2, Title, Default etc. 

If you are planning to create an index like a table of contents for your 
document, you have to apply a hierarchy of headings to the it. That 
means that you should choose the style named Title for the title of 
your document and the style named Heading 1 for the main-headings, 
followed by Heading 2 for the sub-headings and so on. 

Clear Formatting clears all the formatting from the highlighted 
selection, leaving only the plain text.
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 4.5.5.2 The Insert tab
Now let's have a look at the Insert tab.

If you click Picture the My Pictures folder will be open and you can 
choose a picture to insert into the document.

If you click Clip Art the Clip Art Gallery will be open and you can choose a 
clip art to insert into the document. You can search for special clip arts to 
fit your purpose like Christmas, birthday etc.
Table: Inserts a table into the document. You can drag through the grid to 
select the number of rows and columns in the table. When you are 
satisfied, click the last cell. 
Click Shapes to open a menu that gives you plenty of shapes to choose 
from. Click the shape you like. Now the cursor will change to a cross-hair 
and you can draw the shape by click&hold and moving the mouse. 

Word allows you to use headers, footers and page numbering. A header is a line or lines 
of text written repeatedly above the top margin of successive pages. Footer is a line or 
lines of text that are repeatedly below the bottom margins of successive pages. Headers 
and footers may be used for repeating a title of a document or to show the document's 
name and path (the place where it is saved on the hard drive).
Page numbering will automatically number the pages of your document consecutively. 
If you are planning to use headers or footers it is advisable to create them from the 
beginning, otherwise it might screw up your formatting.

Click Header to open a menu that gives you different styles of headers. 
Choose the one you like. 

Click Footer to open a menu that gives you different styles of footers. 
Choose the one you like. 

Click Page Number to open a menu that gives you different styles of 
numbering. Choose the one you like. 

Click SmartArt to open a menu that gives you different styles of diagrams. 
Choose the one you like. 

50



Computer Applications                                              Introduction to Word Processing

Now you can create diagrams like the following example:

Click Text Box to open a menu that gives you different styles of text boxes. 
Choose the one you like. 

You can create text with a special design (font) using the WordArt button. 
For example, you could create a special heading, like this: 

Click Symbol to open a menu to open a menu that gives you different 
types of symbols. Choose the one you like. If you cannot see the symbol 
you are looking for, you can click on More Symbols to get a list of all 
symbols available.
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 4.5.5.3 The Page Layout tab

Click Page Layout Tab to open the page setup. Here you can change the basic page 
layout, like the paper orientation (portrait or landscape), size, the margins and borders.

 4.5.5.4 The Review tab

Last but not least let's have a look at the Review tab.

If you click Spelling & Grammar, a window will be displayed that checks 
the spelling and grammar of the document.

Opens thesaurus (See Chapter 4.2 Advantages of word-processing 
software).
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 4.5.5.5 The Status Bar

The status bar is at the bottom of the window.

From left to right, it has the following functions.

Page Number: Shows the number of the page currently displayed and the number of total 
pages.

Word Count: Counts the number of words in your document.

Spelling and Grammar check: Shows if spelling or grammar mistakes were found. Click 
on it to correct mistakes.

Language: Displays the language for the selected text. Click to open a menu where you 
can choose another language for the selected text or for the current paragraph. Tick or 
untick "Do not check spelling or grammar" to exclude/include the document from spelling 
and grammar check. 

View Shortcuts: Changes the view.

Zoom: Shows the current zoom-level. 100% is normal.

Zoom Slider: Use the slider to zoom in and out.

 4.5.5.6 Index

If you are planning to create a long document with plenty of headings and subheadings it 
might be worth to create an index like the one you can find in the beginning of this book.
The advantage of having an index is that readers are able to find specific topics within your 
document easily.

Note: If you choose to create an index, you have to create a header or footer with 
successive page numbers and a hierarchy of headings (see above). 

After you have added the page numbers and headings to the document, click Reference in 
the tab-bar. Click Table of Contents in the top right-hand corner and choose the style the 
you like. 
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 4.6 OpenOffice

Now that we know the famous office software Microsoft Office, lets have a 
look at OpenOffice. Like MS Office, OpenOffice is a package of different 
software necessary in an office like database, presentation and 
spreadsheet. The specific software within OpenOffice that is responsible 
for word-processing is called Writer. It can be used to create, format and 
edit almost all kinds of text documents such as private letters, 

applications, assignments, etc. It gives you tons of  different formatting options, including 
putting pictures in a text document. For example, this book has been created using 
OpenOffice Writer.
The biggest advantage of OpenOffice compared to Microsoft Office, is that OpenOffice is 
for free, therefore you can ask the organizer for a free copy of the software, if you have a 
storage device (flash or CD)

If you launch OpenOffice Writer, it will display an empty page and some buttons around it:
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Menu bar:The menu bar gives you different categories like File, Edit, View etc. If you click 
one of the categories a menu will pop up showing you further options within that category.

 4.6.1.1 The Standard bar: 

New: This button opens a new text document (short cut key: Ctrl+N).
Open: This button opens previously saved files (Ctrl+O).
Save: This button saves your work (Ctrl+S).
Export as PDF:  Export your work as a PDF file.
Print: Prints out your document if a printer is connected and switched on 
(Ctrl+P).
Page Preview: Page Preview shows you your document in the way it 
would be printed out.
Spell checking: The left button opens a window that checks spelling and 
grammar  word by word through the whole document. The right one 
automatically checks spelling as you type, and underlines errors. 
Cut, Copy and Paste. Those three buttons allow to cut, copy and paste 
within your document.(for further explanation see above 3.7.2 copy and 
moving files and folders).
Format Paintbrush: Adopts a format, for example bold and applies it to 
another part of the document. First select some text or an object, then 
click this icon. Then click on or drag across other text or click an object to 
apply the same formatting.
Undo, Redo: Undo reverses the last command or the last entry you 
typed. To select the command that you want to reverse, click the arrow 
next to the Undo icon on the Standard bar (Ctrl+Z).
Redo reverses the action of the last Undo command. To select the Undo 
step that you want to reverse, click the arrow next to the Redo icon on 
the Standard bar (Ctrl+Y).
Table: Inserts a table into the document. You can also click the arrow, 
drag to select the number of rows and columns to include in the table, 
and then click in the last cell. 
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Show draw functions: If you click here, the draw functions will be 
displayed in the following tool bar.

The drawing bar contains frequently used editing tools. Click the arrow 
next to an icon to open a toolbar that contains additional commands. On 
the drawing bar you can select different shapes and symbols and insert 
them into your document. Furthermore you can create text with a special 
design (font) using the font-work button (     ), for example, you could 
create a special heading, choosing one of the following options: 

Find & Replace: This option allows you to search for a particular word in 
the whole document and replace it with another word of your choice. 
Non-printing Characters: If you activate this button, empty space 
between words (·), empty paragraphs (¶) and tab stops (  →  ) will be 
displayed as indicated in brackets.
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 4.6.1.2 Formatting bar

The Formatting bar contains several text formatting functions.

Styles and Formatting.

Styles and Formatting specifies whether to show or hide the Styles and 
Formatting window, which is where you can assign and organize Styles.

Apply Style

Apply Style assigns a style to the current paragraph, selected 
paragraphs, or to a selected object.

Font Name

Font Name allows you to select a font name from the list or enter a 
font name directly. 

This font is called Arial. 
This font is called Times New Roman. 
This font is called Comic Sans MS. 

Font Size

Font Size allows you to choose between different font sizes from the list, or to 
enter a size manually.

The font size is 8.
The font size is 12.
The font size is 16.
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Bold

Bold makes the selected text bold. If the cursor is in a word, the entire word is made 
bold. If the selection or word is already bold, the formatting is removed.

Italic

Italic makes the selected text italic. If the cursor is in a word, the entire word is made 
italic. If the selection or word is already italic, the formatting is removed.

Underline

Underlines or removes underlining from the selected text. 

Left

Align Left aligns the selected paragraph(s) to the left page margin.

Center

Centred centres the selected paragraph(s) on the page.

Right

Align Right aligns the selected paragraph(s) to the right page margin.

Justify

Justified aligns the selected paragraph(s) to the left and the right page margins. If you 
want, you can also specify the alignment options for the last line of a paragraph by 
choosing Format → Paragraph → Alignment from the file menu. 

Numbering On/Off

1. Numbering On/Off adds or removes numbering from the selected paragraphs. 
2. To define the numbering format, choose Format → Bullets and Numbering. 
3. To display the Bullets and Numbering Bar, choose View → Toolbars → Bullets 

and Numbering.
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Bullets On/Off

• Bullets On/Off assigns bullet points to the selected paragraphs, or removes 
them from bulleted paragraphs. To change the style of the bullet points right-
click into the paragraphs then select Numbering/Bullets from the menu.

Decrease Indent

Click the Decrease Indent icon to reduce the left indent of the current paragraph or 
cell content and set it to the previous default tab position.

Increase Indent

Click the Increase Indent icon to increase the left indent of the current paragraph or 
cell content and set it to the next default tab position.

Font Colour

Click to apply the current font colour to the highlighted characters. You can also click 
here, and then drag a selection to change the text colour. Click the arrow next to the 
icon to open the Font colour toolbar where you can select a different colour. 

Highlighting 

Highlighting applies the current highlight colour to the background of a text selection. 
If no text is selected, click the Highlighting icon, select the text that you want to 
highlight, and then click the Highlighting icon again. To change the highlight colour, 
click the arrow next to the Highlighting icon, and then click the colour that you want. 

Highlighting paragraph

Highlighting paragraph works in the same way as highlighting but the whole 
paragraph gets highlighted.
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 4.6.1.3 Status bar
The Status Bar contains information about the current document and offers various 
buttons with special functions which are explained below, going from left to right. 

Page Number
The current page number is displayed in this field of the status bar. A double-click opens 
the Navigator, with which you can navigate in the document.

Current Page Style
Displays the current Page Style. Double-click to edit the style, right-click to select another 
style.

Language
Displays the language for the selected text. 
Click to open a menu where you can choose another language for the selected text or for 
the current paragraph. 
Choose None to exclude the text from spell-checking. 
Choose Reset to Default Language to re-apply the default language for the selection or the 
paragraph. Choose More to open a dialogue with more options.
Insert Mode
Displays the current insert mode. You can toggle between INSRT = insert and OVER = 
overwrite.
Selection Mode
Displays the current selection mode. You can switch between STD = Standard, EXT = 
Extend, ADD = Add, BLK = Block selection. Usually the setting should be STD.
Document Modification
If changes to the document have not yet been saved, a "*" is displayed in this field on the 
Status Bar. This also applies to new, not yet saved documents.
View Layout
Three controls on the Writer Status Bar allow to change the zoom and view layout of your 
text documents. The View Layout icons show from left to right: Single column mode. View 
mode with pages side by side. Book mode with two pages as in an open book.

Zoom

The Zoom specifies the current page display zoom factor. Drag the zoom slider to 
the left to show more pages, drag to the right to zoom into a page and show a 
smaller area of the page. 
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 4.6.1.4 Additional formatting options

 4.6.1.4.1 Page Setup

Click Format, Page to open the page setup. Here you can change the basic page layout, 
like the paper format, portrait or landscape, the margins, header, footer and borders.
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 4.6.1.4.2 Line spacing

If you want to in- or decrease the space between the lines of the text, you can highlight it, 
right-click on the highlighted area, select line spacing, and then choose amongst Single, 
1,5 lines and Double.

Example: The paragraph below has double line spacing.

If you want to in- or decrease the space between the lines of the text, you can highlight it, 

right-click on the highlighted area, select line spacing, and then choose amongst Single, 

1,5 lines and Double.

 4.6.1.4.3 Superscripts and subscripts

Writer allows you to insert superscripts and subscripts. A superscript is a textual addition 
written slightly above a character on a line of text. This is normally used when writing dates 
like '3rd of Jan 2012’. The 'rd' is the superscript in this case. A subscript is a textual addition 
written slight below a character on a line of text. The subscripts are normally used when 
writing chemical formulas. I.e. CO2. In this case ‘2’ is actually the subscript.
Sometimes, as in the case of dates, Writer will automatically apply super/subscript. If you 
want to apply super/subscript manually, you have to highlight the letters/number that you 
want to change. Right-click in the highlighted area and select Style and choose between 
Superscript or Subscript.
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 4.6.1.4.4 Headers & Footers
Writer allows you to use headers and footers. A header is a line or lines of text written 
repeatedly above the top margin of successive pages. Footer is a line or lines of text that 
are repeatedly below the bottom margins of successive pages. Headers may be used for 
repeating a title of a document and footers for showing successive page numbering such 
as in this book or to show the document's name and path (the place where it is saved on 
the hard drive).
If you are planning to use headers or footers it is advisable to create them from the 
beginning, otherwise it might mess up your formatting.

To create a header click Insert, Header, Default. Now a empty textbox will appear at the 
top of each page. Whatever you write into the text box will appear on each page.

To create a footer click Insert, Footer, Default. Now there appears an empty text box at 
the top of each page. Whatever you write into the text box will appear on each page.

You can insert special fields into the header or footer. Those can display page numbers, 
date, time, path author etc. They will be updated automatically.
To do so, click the text field and then click Insert, Field. Now you can choose the kind of 
field you want.

 4.6.1.4.5 Index

If you are planning to create a long document with plenty of headings and subheadings it 
might be worth to create an index like the one you can find in the beginning of this book.
The advantage of having an index is that readers are able to find specific topics within your 
document easily.

Note: If you choose to create an index, you have to create a header or footer with 
successive page numbers first (see above).

After you have added the page numbers to the document, click Insert, Indexes and 
Tables,  and click Indexes and Tables. A menu will appear which enables you to 
configure the index.
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 4.7 How to format a document

Formatting refers to adjusting the appearance of the document to make it look appropriate, 
attractive and organized. There are some rules to be followed if you format a document.

 4.7.1 Before you type the document

1. Page setup
First of all you should determinate the page setup. Of course you can change your page 
setup even after you are finished typing, put that might mess up all the formatting you have 
done by then. 

2. Headers, footers and page numbering

If you are planning to use headers, footers or page numbering you should create them 
from the beginning on because they require space on the document. 

Note that you will have to use page numbering if you want to create an index. 

 4.7.2 While you are typing the document

1. Index

If you want to create an index, you should specify your headings and sub-headings while 
writing the document. You can change the style of the headings and sub-headings later 
without disturbing the index.

2. Page break

If you want a certain paragraph of your document to start at the next page you should use 
page break. Move the cursor to the beginning of the paragraph that you shift to the next 
page and press Ctrl+Enter(↵). 

3. Bullet-points and numbering

Apply bullet-points and numbering to create lists. 
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 4.7.3 After you are finished typing

1. Spell and grammar check

After you are finished typing, you should check the spelling and grammar of the document. 
Some mistakes will be found automatically by the word-processor but you should still read 
the document on your own several times to make sure that there are no mistakes left and 
that everything fits together logically. 

2. Styles

Now you can change the style of your document, which means changing the font, the font-
size, bold, italic, underlined, alignment, font-color, highlighting and background colour. 
You must always keep in mind, that changing the style should make your document look 
structured and organized. The document should be clear to any reader. For example, you 
could use bold or font-color to highlight important terms and italic to point out quotations. 
It is also important to use the same kind of style to emphasize the same objects 
throughout the document. If you want to emphasize technical terms by making them bolt, 
make all the technical terms bolt and not just some of them. Never use different styles for 
the same objects, so do not make some technical terms bolt and other underlined. 

3. Paragraphs

Sentences that belong together form a paragraph. Paragraphs make it easier to read your 
document, because they show you which sentences discuss the same topic. 

4. De-/ increase intent

You can de-/ increase the intent of lines and paragraphs. This can be used to emphasize 
certain paragraphs. Increased intent in combination with italic is often used to point out 
quotations. 

5. Pictures, word-art/font-work, text-boxes and SmartArt

Even if you have inserted pictures, word-art/font-work, text-boxes or SmartArt while typing 
the document, it is advisable to check if they are still in the right position after you finished 
typing and you have done some of the formatting. 

6. Final checking

When you are finished with all the typing and all the formatting, you should again read 
through your document several time to make sure, that everything is in the right place. If 
you are sure, that everything is the way you want it, give the document to another person, 
because four eyes see more than two. 
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End of Chapter 4 Questions

1. Explain in precise terms what word-processing software can do.

2. Discuss the terms that are used in the definition of word-processing software in a 
few lines.

3. Write an essay about the happiest moment of your life. This essay should consists 
of 100 to 200 words. Name this document “Essay Happiest Day” and create a folder 
that is named after you (e.g. Thabo Letsatsi) in My Documents → Learners. If you 
already have your own folder, simply save the document in your own folder. 

4. If you have a flash-drive or if you can borrow one, you can now copy and save the 
document from 3.) on it. 

5. Open the document from 3.) again and use the Save As function to save it under 
the file-name “The happiest day in my life“ in your folder. 
Close the document and all word-processing software. Now you can delete the 
copy of the document that is named “Essay Happiest Day”, so only the one named 
“The happiest moment in my life“ is left. 
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Chapter 5  

Introduction to spreadsheets

In this chapter we will have a look at spreadsheet software and see how it is used. We will 
discuss some aspects of spreadsheets. You will learn more about formulas and function 
that are normally used for calculation purposes.
There are two common spreadsheet software: Microsoft Excel and OpenOffice Calc. In 
this chapter we will explain spreadsheet software in general, we will not have a separate 
look at Microsoft Excel and OpenOffice Calc. Most of the functions in Microsoft Excel and 
OpenOffice Calc are the same, only the GUIs look a little different, so you will have to 
figure out some stuff on your own. 

Learning objectives

✔ Define in precise terms what a spreadsheet is.

✔ Explain features of spreadsheet.

✔ Create a spreadsheet document.

✔ Edit and format a spreadsheet document.

✔ Use formulas and functions in.
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 5.1 Introduction to Spreadsheet

Spreadsheets are widely utilized in the business world. Knowing how 
to work with them might be useful career skill. 

A spreadsheet is a worksheet that presents a data in a grid of rows 
and columns.
Spreadsheet can be used to organize, calculate and present data. 
Therefore spreadsheets are often used by businessmen who have 

to make decisions base on huge amounts of data. Neverthless 
spreadsheet are not restricted to be used by businesses only, individuals and 

family members use them to organize things like budgets. 

 5.1.1 Electronic spreadsheet

An electronic spreadsheet or worksheet is a computerized version of a 
manual spreadsheet. Working with a spreadsheet on a computer eliminates 
time consuming and tedious activities that one goes through when setting 
up a manual spreadsheet. Electronic spreadsheets have made things easy 
for us as we enter the information that we want on the spreadsheet and then 
key in the formulas that we need. The spreadsheet software does all the 
calculation for you. Spreadsheet software has another feature, automatic 

recalculation; when you change one value or calculation on the spreadsheet, all the 
dependent values on the spreadsheet are automatically recalculated to reflect the change. 
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 5.2 The first sheet
To launch spreadsheet software, choose either Microsoft Excel or OpenOffice Calc from 
the start-menu. You will see a grid and some menu-bars. 

The boxes formed by the intersection of columns and rows are called cells and they are 
identified by letters and numbers. The columns are named by letters (A, B, C etc.) and the 
rows are named by numbers (1, 2, 3 etc.).The cell that the cursor rests in is called the 
active cell or current cell. 

In the picture above a column is marked green and a row is marked orange and. The 
column is identified by the letter B and the row by the number 4; so the brown cell that is 
as well in column B and in row 4 is called cell B4.

If a cell is to small to display all its content, you can choose optimal column width and 
optimal row heights by double-clicking the column's/row's border. 
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It is possible to have several  in one spreadsheet-document. You can switch between the 
different sheets of your spreadsheet by clicking the Sheet 1, Sheet 2, etc. tab of the 
window. You can rename the different sheets by double-clicking on them. 

 5.2.1 Active cell

If you click a cell in the spreadsheet, it will turn active. The active cell is surrounded by a 
black box (see picture above). You can move the active cell by clicking on a different cell 
or by using the arrow-keys. You can also move to the cell below by pressing Enter and to 
the cell on the right by pressing Tab. 

If you want to type into a cell, you have to activate it first by clicking it. Now that the cell is 
active, you can type the content into it. There is one big difference between spreadsheet 
and word-processing software: If you press Enter in a spreadsheet, you will move the 
active cell to the cell below. If you only want to create a new line within the active cell, you 
have to press Ctrl+Enter. 
You can edit within a cell on your spreadsheet by typing a new entry over an existing one 
or by editing part of the information within the cell. To overwrite a cell, turn it active. What 
ever you type in now will replace the previous content. To edit a cell, double-click the cell 
or press F2. 
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 5.2.1.1 The fill-handle

The active cell has a small black square on its 
bottom right-hand side (see picture). This square 
is called fill-handle. You can use the fill-handle to 
fill data into worksheet cells. If you select two or 
more adjacent cells that contain data and drag, 
the remaining cells are filled with the pattern that 
is recognized in the data. This function is called 
AutoFill and it can recognize many different 
patterns like numbers, letters, days of the week, 
months, etc.

1. On a sheet, click in a cell, and type a number.
2. Click in the cell below and type another number; then click back in the cell 

where you typed the first number.
3. Now highlight both cells. 

4. Drag the fill handle in the bottom right corner of the cells (the pointer will 
change to a cross) across the cells that you want to fill, and release the mouse 
button.

5. The cells are filled with numbers.

Note: Hold down Ctrl if you do not want to fill the cells with different values.
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 5.3 Entering Formulas
In a spreadsheet there are two levels. The first one is the value-level and the formula-level. 
The value-level is the one that you usually see on the grid. It is the level were you enter 
the data for the spreadsheet software to work with. The formula-level is lying “underneath” 
the data-level so you usually cannot see it. Here you enter the formulas that perform 
calculations using the data from the value-level. 

Note: Formulas always start with “=”, so if you want to enter a formula into a cell, 
first press “=”. 
If you want to enter “=” as a character and not as the beginning of a formula, 
enter “'=”

In order to illustrate entering formulas let us begin with a clear spreadsheet. 
1. Select the cell A1 and type the number 3, then press Enter. 
2. Select the cell A2 and type the number 5, then press Enter. 
3. Select the cell A3 and type “=A1+A2” then press Enter. 
4. The result 8 will appear in cell A3. 

The numbers 3, 5 and 8 are on the value-level, so they 
are displayed on the spreadsheet. The formula 
“=A1+A2” is on the formula-level, so you cannot see it 
on the value-level. If you want to display the formula in 
the cell A3, you have to select the cell and press F2 or 
you select the cell and look at the formula-bar (see 
picture). When you edit a cell containing a formula, the 
formula is displayed and the value is hidden. 

The big advantage of spreadsheet software is that if you change the data in one of the 
cells A1 or A2, the result in A3 will automatically be updated; so if you change A1 from 3 to 
7, the result in A3 will be changed to 12. 

Formulas can be given as standard arithmetic operations as above or as functions. For 
example. we could use the function "=SUM(A1:A2)" for cell A3 instead of the arithmetic 
operation and we will still get the same result. 
For calculating the sum of cells' values, there is also the possibility of using the sum-button 
(∑). Mark the cells that you want to add up and then press the sum-button. The result will 
be placed below or right of the marked cells. 

72



Computer Applications                                                   Introduction to Spreadsheets

Examples of functions in use:

Function Meaning

=SUM(A1:A12) Add the contents in the range (A1...A12)

=AVERAGE(A1:A12) Find the average of the contents in the range (A1...A12)

=MAX(A1:A12) Find the maximum value of contents in the range (A1...A12)

=MIN(A1:A12) Find the minimum value of contents in the range (A1...A12)

=COUNT(A1:A12) Find the total number of cells in the range (A1...A12)

=PRODUCT(A1:A12) Find the product of the contents in the range (A1...A12)

There are many types of different formulas in spreadsheet software: numeric formulas,  
text formulas and logical formulas.

Numeric formulas: These type of formulas use the following arithmetic operators: addition 
(+), subtraction(-), multiplication(*), division(/), percentage (%) and exponent (^) as in the 
ordinary terms of usage.

Text formulas: These types of formulas are used to manipulate text. The text in this type of 
formula has to be enclosed in quotation marks. A text formula can be used to combine text 
from several cells in one cell. The ampersand (&) symbol is used to combine strings of 
text.

Logical formulas: These are statements that evaluate a condition. They produce a logical 
value TRUE or FALSE. They use the following comparison operators: equal (=), greater 
than(>), less than (<), less than or equal to(<=), greater than or equal to (>=), and not 
equal to (<>) as in the normal usage- of the operators. For example. the formula “=A1<50” 
produces the logical value TRUE if the value in cell A1 is less than 50; otherwise the 
formula produces the logical value FALSE.
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 5.4 Copy and Pasting in Excel

Copying with spreadsheet software is much like copying with word processing 
software. To copy the contents of cells, we select the cell in which our 
data is at and then press Ctrl+C. By doing this computer places the 
contents of whatever is copied on the clipboard. 
Since the copied data is on the clipboard you have to choose the cell in 
which you want to paste the content. After selecting the target cell, you 
press Ctrl+V to insert. 

 5.5 Formatting a Cell

There are many ways of changing the appearance of a worksheet. Using the tool bar, 
similar to word processing, modifies fonts and font sizes. All such changes may be applied 
to a selected cell or group of cells or to individual highlighted characters within the cells.

 5.6 Inserting and deleting

 5.6.1 Inserting and deleting cells

Sometimes you may need to insert or delete cells. You can insert blank cells or entire 
blank rows and columns on a worksheet.

When you insert cells, the other cells on the worksheet are shifted to make room for the 
new cell. When you delete cells, the surrounding cells shift to till in the space. When you 
clear cell, only the contents of the cell are removed.

To insert cells:
Select the range of cells which have the same size as the new ones you want to insert. 
Right-click on the selected cells and click Insert form the context-menu. Now choose the 
direction you want the surrounding cells to move. Then confirm your choice.

To clear and delete cells:
Select the range of cells you want to clear and press Delete on the keyboard. The content 

of the cells will be cleared and they will remain empty. 
Otherwise select the range of cells you want to delete. Right-click on the 

selected cells and click Delete... in the context-menu. Now choose the direction 
you want the surrounding cells to move. Then confirm your choice. Now the 

cells will disappear and their place will be taken by other cells. 

74



Computer Applications                                                   Introduction to Spreadsheets

 5.6.2 Inserting and deleting rows and columns
When you insert a row or a column, a new blank row or column is created and the existing 
rows or columns are shifted to make room for the inserted ones. 

Select the number of rows or columns you want to shift to open space for the new 
rows/columns. Right-click into the marked area and select Insert from the context-menu. 

When you want to clear or delete a row/column, you mark the row/column that you want to 
clear/delete. Now right-click into the marked area and select Delete or Clear Contents 
from the context-menu. 

 5.7 Graphic objects and charts
You can put graphic objects and charts on spreadsheets. The graphic 
objects are not anchored to a cell but they can be moved around in the 
entire sheet. 
To make a chart out of data, mark the cells containing the data and then 
select Insert, Chart. 

Examples of commonly used charts are bar/column chart, line chart, 
and pie chart.

 5.7.1 Bar/Column charts
A bar chart is a good way of representing data visually and one could easily see where 
some values are larger than the other.
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 5.7.2 Line Chart
Line charts are a good choice when you do not want to have direct visual presentation of 
data, but you want to see how the values are developing or have developed.

 5.7.3 Pie Chart
A pie chart is useful whenever you need to see how much each item contributes to the 
whole portion.
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End of chapter 5 Questions

The table below outlines rainfall levels, in millimetres, for seven Lesotho districts during 
six-month period:

RAIN FA LL (MM)

Jan Feb Mar Apr May Jun

Maseru 56 51 47 42 30 22

Thaba-Tseka 64 58 53 47 34 24

Leribe 76 68 65 56 42 26

Butha-Buthe 59 50 51 43 30 23

Mafeteng 49 52 42 33 26 17

Mohale’s Hoek 53 54 49 44 35 24

Quthing 42 45 36 29 20 11

Enter the table into a spreadsheet and complete the following tasks:

1. Widen the first column so that all the districts names will be visible.

2. Save the spreadsheet as RAIN 1.

3. Add a row below the details of Quthing to show the average monthly rainfall.

4. Add a new column after the June rainfall statistics to show the total rainfall in each 
district over the period.

5. Change the rainfall in Quthing during March to 58.

6. Insert a new row between the rows holding Mafeteng and Mohale‘s Hoek rainfall 
statistics:
Enter the following details:
Mokhotlong 65, 63, 57, 50, 39, 21

7. Obtain the total rainfall in Mokhotlong during the period. 

8. After this insertion of new data what is the average monthly rainfall?
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9. According to your calculations, which district had the most rainfall and which had 
the least rainfall including the new data that you have inserted?

10.Save the spreadsheet as RAIN2.

11. Close RAIN 2 and open RAIN 1. 

12.Make a line chart using the data in RAIN1. 

13.Change the rainfall in Thaba-Tseka during March to 20 and watch the chart.
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Chapter 6  

Computer Networks and Internet

In this chapter you will be introduced to the basics of computer networks and Internet. We 
will define different types of computer networks. Then we will discuss the Internet, explain 
how computers on the Internet are named and connected.  Finally we will focus on working 
within the World Wide Web (WWW), doing web research and using electronic mail.

Learning Objectives

✔ Define a computer network and types of computer networks.

✔ Define the Internet and explain the importance of the Internet.

✔ Explain how computers are named and addressed on the Internet.

✔ Explain the World Wide Web.

✔ Explain what is an Email and how it operates.
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6.1 Computer Networks

A computer network is a collection of two or more computers that are connected together 
by communication links so that they are able to communicate, share resources and data. 
There are three types of computer networks: Local Area Networks (LAN), Metropolitan 
Area Networks (MAN) and Wide Area Networks (WAN).

Local Area Network (LAN)

Local area networks, generally called LANs, are widely used to connect personal 
computers and workstations in a company, offices and factories to share resources (e.g. 
printers, Internet and storage) and exchange information. There are privately owned 
networks within a single building or campus of up to a few kilometres in size. One of the 
things that distinguish LANs from other networks is their topology, which is actually the 
physical layout of a local area network. We will discuss this topologies in a short while.

Metropolitan Area Network (MAN)

A Metropolitan Area Network or MAN are formed by computers scattered over a large 
geographical area like a city. They may be used to link different office buildings in a city. 

Wide Area Network (WAN)

A Wide Area Network or WAN are networks that cover a large geographical area, often a 
country or continent. 

 6.1.1 LAN Topologies

Computers on a LAN are connected in certain arrangements. The arrangements 
are called topologies. Basically, a topology is the physical layout of a LAN. 
Computers on a LAN can be arranged in the following three topologies: star, 

ring and bus networks.
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Star Network

Star networks are one of the most common computer network topologies and are also 
used in the SSB. In its simplest form, a star network consists of several computers which 
are connected to a central switch that acts as a conduit to transmit data.
A star network can be extended by a server-computer. Files, like documents, pictures, 
music, etc. that are stored on the server can be accessed, used and copied from all the 
client computers. For example, a song that is stored on the server-computer only, can be 
played on all client-computers simultaneously without having to be stored on either one of 
the client-computers. Drawing 2 below illustrates the star topology.
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A Ring Network

In a ring network, computers are connected by a single communication channel in a closed 
loop. All computers are considered equal to one another. No host controls communication. 
Each computer may communicate directly with the other computer on the network along 
the communication channel. The graphic below illustrates the ring topology.

Bus Network

In the bus network a number of computers are connected to a single communication cable. 
Every computer can communicate directly to every other computer on the network.

The graphic below illustrate the bus network.
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 6.2 The Internet

 6.2.1 What is the Internet?

The Internet is the global wide area computer network. It links hundreds of 
thousands of academic, government, military, scientific and public 
computers together, enabling literally millions of people from all over the 
world to share information. The Internet is made up of little Local Area 
Networks (LANs), city-wide Metropolitan Area Networks (MANs ) 
connecting computers for organizations all over the world.

 6.2.2 Why learn about the Internet?

The Internet is the most commonly used computer networks. Mainly, the Internet allows 
users to access a wide variety of all kinds of information stored on servers (special 
computers that are allays turned on and connected to the Internet) and it allows 
communication between Internet users. Information on the Internet could be 
communicated in the form of text, pictures, videos and a combination of many other 
presentation forms. We can find information on almost every topic on the Internet 
(including topical affairs). The big advantage of storing information in the Internet is, that 
this information can be available world wide and that it can be accessed for free. Most 
companies advertise there products on their websites and many also offer you to buy them 
at the instant. Text and pictures from the Internet can be printed out or copied to a word-
processing software so that they are available to you even when you are not connected to 
the internet any more.  

A part from getting various kinds of information on the internet, we can communicate with 
other Internet-users by using chat-rooms, social networks such as facebook, electronic 
Mail or even by making voice and video calls. The Internet has had and still has a great 
deal of positive impact in education. It has improved teaching and learning a lot where 
students and teachers use it. Teachers and students can use the Internet as a source of 
valuable information. They can communicate with other persons from remote places to 
enrich one another on many educational concepts, subjects and topics. As a result, they 
are able to make better preparations and lessons.
The Internet has made distance learning a success in many ways where it is applied. One 
of the most important issues in distance education is fast, timely and cheap 
communication between students, teachers, and administrators. With the Internet, 
teachers can easily send and study information, assignments and results of students in a 
short time. Students can easily send assignment answers, check the results and 
communicate with their teachers and administers. So as you can see, the Internet has 
broken many barriers in education.
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 6.2.3 Who Owns The Internet?

It's a truly global system. Cables criss-cross countries and oceans, crossing borders and 
linking some of the world's most remote locations to everyone else. And the Internet is still 
growing. More computers link to it every day, and various organizations and companies 
are working to extend Internet access to countries that aren't yet connected. The Internet 
is a giant system made up of much smaller systems. If it's one thing, does it have a single 
owner? Is there some person or entity that controls the Internet? Is it possible for someone 
to own something that spans nations and oceans? 
So who actually owns the Internet? There are two answers to this question:

a) Nobody 
b) Lots of people 

If you think of the Internet as a unified, single entity, then no one owns it. There are 
organizations that determine the Internet's structure and how it works, but they don't have 
any ownership over the Internet itself. No government can lay claim to owning the Internet, 
nor can any company. The Internet is like the telephone system - no one owns the whole 
thing.
From another point of view, thousands of people and organizations own the Internet. The 
Internet consists of lots of different bits and pieces, each of which has an owner. Some of 
these owners can control the quality and level of access you have to the Internet. They 
might not own the entire system, but they can impact your Internet experience.2

 6.2.4 Connecting to the Internet

As an individual. you can connect your computer to the Internet through 
companies that offer Internet access. These companies are called Internet 

Service Providers (ISPs). As a student you should not worry about 
connecting to the Internet as your institute will probably connect on 

your behalf. What is important for you is to understand and know how to 
use it.

2 http://computer.howstuffworks.com/internet/basics/who-owns-internet1.htm
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 6.2.4.1 IP and DNS

Most computers on the Internet can be identified in two ways. Each computer that stores 
information accessible to Internet-users has a name and a numerical address (both 
unique) just as most of us can be located by our names or numerically by our identity 
numbers. The numerical address or Internet Protocol addresses (IP) are normally used by 
computers for communications among themselves and are used by computer 
professionals for technical services. As numbers are easy to forget, naming of computers 
is preferred. Therefore the Domain Name System (commonly referred to as DNS) is the 
method by which all computers that store information accessible to the Internet-users are 
"mapped“. The DNS is essentially a collection of large databases storing the equivalent of 
names and addresses of various host computers connected to the Internet. The databases 
provide the ‘translation' from names to numbers and vice versa. That means that each 
website can be opened with a numerical IP (e.g. 165.165.38.147) and a name in text-
formate (e.g. www.google.ls.co). DNS is used by all computers on the Internet to locate 
other computers on the Internet.

 6.3 World Wide Web (WWW)
If you are familiar with the Internet, you always hear words like ‘WWW’ and 'the Web'. 
What is WWW? This is one applications of the Internet. WWW is a browsing and searching 
system that allows you to explore world-wide digital "web" of information. The system links 
related documents using a very powerful concept called hypertext. Hypertext allows you to 
access information the way you want.

 6.3.1 Viewing documents on the Web

The documents containing hypertext links are viewed through the use of software 
applications called web browsers. The web browser is simply a software application that 
can interpret the links. Your web browser automatically connects you to the computer that 
has the information that you may be searching for and you can retrieve it.
The World Wide Web is very powerful tool that allows even people with little 
computer literacy to access the information on the Internet as they want.

 6.3.2 Accessing and using the Web
To view a website from the Web, the user has to launch a web-browser (like Microsoft 
Internet Explorer or Mozilla Fire Fox) which is a program that displays websites after you 
have entered their a dress. 
Every website is stored on a certain web-server. The web-browser communicates with the 
web-server, downloads the websites from it and presents them to the user. 
If you open a website you will usually see the homepage, which is the main page of the 
website. Starting from the homepage you can navigate through the whole website by 
clicking on links, pictures, etc. or searching for information in a search field.

85



Computer Literacy                                           Computer Networks & Internet

 6.3.3 Web-browsers

If you launch a web-browser like Firefox, you will see the following window:

Address bar: The address bar displays the name of the website you are currently viewing. 
To open a specific website, type in its name in the address bar. If you would like to open 
Google, you type in www.google.com. As you can see, the name of a website consist out 
of three different parts, separate by full-stops: Firstly www which means that you are 
opening a website, Google is the name of the website and .com  is the top-level-domain 
(TLD). The TLD describes a country (e.g.:.uk for United Kingdom), generic (e.g.:.com, .net, 
.org) or infrastructure (e.g.:.arpa) code.

Links: Web-browser read hypertext or web-links. Web-page owners can embed addresses 
of other web-pages into their own web-pages. E.g. the Web Museum Network in Paris 
(www.sunsite.unc.edu/louvre) lets you visit museums from Australia to Singapore by 
simply clicking the museums' name.  

Navigation: If you change the website you are on, you can switch back and forth between 
the different websites by clicking left or right arrow.

86

tab open a new tab

navigation

search the web
search the website

address bar

links



Computer Literacy                                           Computer Networks & Internet

Tab: If you open a website it will be displayed in a tab which is something like a window 
inside of the browser. You can open several tabs at once in the same  browser, so you can 
open more than one websites simultaneously. Switch between the tabs by clicking them. 

Open a new tab: To open a new and empty tab, click the add tab button. If you want to 
open a link in a new tab, hold Ctrl while you click it. 

Search the web: This search-box is connected to a search-engine, mostly Google, and it 
allows you to directly search the web for a certain term, without having to open the google 
website. 

Search the website: Some websites, especially the ones that hold a lot of information on 
a multitude of topics, have a search-box. If you type anything in here, the website you are 
currently using will be searched for that term .

 6.4 Research on the Internet

The Internet is a great source of information on almost all topics, however because there is 
so many information stored in the Internet, it can be quite difficult to specifically find what 
you are looking for. That's way we have so-called search engines. Search engines can 
search through the websites in the Internet looking for terms of your choice. The search-
results are then presented to you as a list of links to the websites where the terms that you 
typed into the search engine where found. Click the links to open the websites. 

There are a lot of different search engines to choose from, but Google (www.google.com) 
is currently the most used one. It has one of the largest databases of Web pages, 
including many other types of web documents (blog posts, wiki pages, group discussion 
threads and document formats (e.g., PDFs, Word or Excel documents, PowerPoints). 
Despite the presence of all these formats, Google's popularity ranking often places 
worthwhile pages near the top of search results.
Google alone is not always sufficient, however. So, getting a "second opinion" can be 
worth your time. For this purpose, we recommend or Exalead (www.exalead.com). 3

3 http://www.lib.berkeley.edu/TeachingLib/Guides/Internet/SearchEngines.html
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 6.5 Electronic Mail (eMail)
Let us now concentrate on email. Email is a method of exchanging digital 
messages from an author to one or more recipients. Modern email 
operates across the Internet or other computer networks. Most emails 
are sent and received in a few seconds, this is the case regardless of 
whether the message is send to someone you are with in the room or 

someone far away in another country. If the email contains a lot of data, 
like pictures or videos, it can take longer for it to be sent. 

To sent or receive emails, you need a email-address. You can get an email-address 
for free by signing up with an email-service. A very common a recommended 
service is google gmail. You can sign up with gmail by typing 
www.googlemail.com in the address-bar of your browser and then clicking create 
account or sign up. Then you have to provide some personal information like your 
name, date of birth etc. You also have to choose an email-address, which usually 
contains your name and is followed by the @ (pronounce 'at') and the service's 
name(e.g.: thabo.letsatsie@gmail.com) and a password. Make sure that your 
password is only known to you and do not pick something to obvious like 123456 or 
abcdef or your name or date of birth. 
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 6.6 Dangers and annoyance 

The Internet is a technology that opens up almost limitless opportunities. Nevertheless you 
should always be considerate when using to avoid the dangers of the world wide web. 

• Spam: More and more companies buy lists of email 
addresses. If you are a regular Internet user the chances are 
that providers will get hold of your email address and send 
send you unsolicited marketing or advertising material to 
you. 
Some providers try to get hold of your email adress by 
offering you to take part in a winning game. To enter the 
game, you have to give your email address first. Of 
course, you cannot win anything but the providers will 
get your email-address and send you spam.

• Viruses: A computer virus is a harmful program that runs without 
permission and tries to spread itself to other computers and may 
damage or delete your files if your computer is infected with it. Viruses infect 
millions of computers each day on the internet. To avoid them, you should use anti-
virus programs and update it regularly that can check files for viruses before you 
open them even if they arrive as email. In general you should always be careful 
about the programs you install and the files you open file using the internet. Don't 
open files send to you via email by people you don't know – even if those files 
appear to be something interesting. 

• Data protection: You should always be careful when asked for your personal data 
over the web. Never enter your bank account into a website and never sent it to 
somebody via email. There are some criminals using the Internet for credit card 
fraud. They will promise to transfer you money if you tell them the details of your 
bank account, but actually they are only planning to steal money from your account. 
You also should not give personal information like your age, address, phone-
number, etc. to strangers over the Internet.  
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End of chapter 6 Questions

1. In precise terms explain what is meant by a computer network.
2. Give three types of computer networks that you know of and discuss them in few 

words.
3. Give three types of LAN topologies and show them graphically.
4. What is the Internet?
5. Who owns the Internet?
6. Give two ways in which websites on the Internet can be identified.
7. What does WWW stand for? 
8. What is a website and what is the homepage?
9. What is meant by an email and an by email-address?

90



Computer Literacy                                           Computer Networks & Internet

Chapter 7

This chapter concerns with the abbreviations, shortcut keys and the references.

 7.1 Abbreviations

ATA Advanced Technology Attachment
Alt Alternative
ALU Arithmetic/Logic Unit
b Bit
B Byte
CRT Cathode Ray Tube
CPU Central Processing Unit
CD Compact Disc
CU Control Unit
Ctrl Control
Del Delete
DVD Digital Versatile Disc
DNS Domain Name System
Esc Escape
F Function
GB Giga Byte
GUI Graphical User Interface
HD Hard Disk
IP Internet Protocol
ISP Internet Service Provider
KB Kilo Byte
LCD Liquid Crystal Display
LAN Local Area Network
MB Mega Byte
MAN Metropolitan Area Network
MS Microsoft
OS Operating System
PC Personal Computer;
PDF Portable Document File
RAM Random Access Memory
ROM Read Only Memory
SATA Serial Advanced Technology Attachment
SCSI Small Computer System Interface
TB Tera Byte
TLD Top-Level-Domain
USB Universal Serial Bus
WAN Wide Area Network
www World Wide Web
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 7.2 Shortcut keys

Win + E Explorer (My Computer), if you don't need the left side you can 
press SHIFT(⇑) and TAB (↔), then ENTER

Win + M Show desktop

Win + D Show desktop

Win + L Log off

Win + F Search

Win + B Show Taskbar

Win + Pause (Break) System Properties

ALT + ENTER Properties from files and folders

ALT + TAB Change application

ALT + F4 Close

Ctrl + C Copy

Ctrl + X Cut

Ctrl + V Paste

Ctrl + S Safe

Ctrl + F Search

Ctrl + A Mark all (files, text .... )

Ctrl + N New

Ctrl + O Open

Ctrl + P Print

Ctrl + W Close file or tab – depends on the application

Ctrl + ENTER Page break, full-screen – depends on the application

Ctrl + Cursor Jump to the end or beginning, or to the next word

Ctrl + Cursor + SHIFT(⇑) Mark one word

Ctrl + B Make a marked word bold

Ctrl + I Make a marked word italic

Ctrl + U Make a marked word underlined
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F1 Help

F2 Rename (works in Excel or Calc, too)

F3 Search

F4 Opens pull-down menu

F5 Refresh

Print Take a picture of the whole screen

Print + ALT Take a picture of the active window

Win + R Run

→ What can you do with run?
      You can open programs or drives, or paths with the following commands

calc Calculator

control panel Control Panel

mspaint Microsoft Paint

c:, d:, e: ..... Open drives

msconfig System Configuration Utility

cmd Command Prompt

notepad Notepad

Winword Opens  Microsoft  Word  (If  installed,  otherwise  Wordpad  will 
open)

Wordpad Opens Wordpad

Excel Opens Microsoft Excel (If installed)

Clipboard Opens the Clipboard
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